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Using Microsoft Access 
Relational Queries 

Creating a query can be a little different when there is more than one table involved. First of all, if 
you want to create a query that makes use of more than one table, it is necessary to make sure the 
tables have the necessary relationships created. Secondly, in your query design, you will be selecting 
fields from more than one table, which can sometimes be a little confusing. 
In the following exercises, we will be using a database called Music Collection 2.mdb. This is similar 
to the one you created in the previous exercises. The only difference is that it has a lot of CD and 
Songs records already entered. If this database is not available, you can enter some of your own 
records in to the one you have created, but the exercises will assume you are using records in the 
Music Collection 2.mdb database. 
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Exercise 1. Checking the Existing Records 
1) Begin by opening the Music Collection 2.mdb database. 
2) Open the CDS table. 7 CDs have already been entered. 
 

 
 
3) Close the table and open the SONGS table. Songs for each of the CDs in the CDS table have 

already been entered. 
 

 
 
4) Close the table. 
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Exercise 2. Creating a Relational Query 
1) Go to the Queries section of the Database Window. 
2) Double click on the option which says Create a Query in Design View. 
 

 
 
3) Double-click on CDS and SONGS to add them both to the Query Design window. 
4) Click Close to close the Show Table dialog. 
5) Resize and adjust your design window so that you have enough room to work with. 
 

 
 

 

We will start by creating a query which shows all songs by a particular artist. We want the results of 
the query to display some fields from the Songs table and some fields from the CDS table so we 
know which CD each song is found on. 
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6) Double click on each of the following fields to add them to the QBE (Query by Example) grid. 
 

Field From table:
Artist SONGS 
Song Title SONGS 
Genre SONGS 
CD Title CDS 
CD Type CDS 
Track # SONGS 
Released CDS 

 
7) Under the Artist field, enter the following parameter criteria: 
 

like [Enter the name of an artist] & * 
 
Your query design should look similar to the example below. 
 

 
 
8) Click the View icon  to test the query. 
 

 
 
9) For the criteria, enter Missy. 
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In the query results, you may notice that one of the artist entries in the results is spelt differently from 
the others (the second one in the above example). If we hadn’t used a wildcard, we would only see 
entries that were exactly the same as the criteria so that one may not have appeared. 
 
10) Correct the differently spelt entry so that it is the same as the others. 
11) Click the View icon  to return to the design view. 
12) Click the Save icon   to save the Query. 
 

 
 
13) Enter artist search as the query name. 
14) Close the query. 
 
Note Query results are really just a selection of data from the tables in the database. When you edit data in 

a query result, it is just the same as editing the data directly in the tables. 
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Relational Reports 
Creating a report in a relational database is much the same as creating a report from a single table 
database. You can create a report directly from the table(s) or you can create a report based on a 
query (which in many cases is based on more than one table). 
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Exercise 3. Creating a Multi-table Report 
In the following exercise, we will create a report based on more than one table, which will list all of 
the songs in the database grouped by genre. 
1) From the database window, change to the Reports section. 
 

 
 
2) Double-click on the option which says Create report by using wizard. The report wizard will begin. 
3) Select the following fields for the report. 
 

Field Name From Table:
Song Title SONGS 
Artist SONGS 
Genre SONGS 
CD Title CDS 
Released CDS 

 

 

 

4) Click Next to continue. 
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5) For the next step of the wizard, make sure view by SONGS is selected and click Next to continue. 
6) In the next step, double-click on Genre in the list of fields to add that field as a grouping level. 

This is because we want the songs grouped by their genres. 
 

 
 
7) Click Next to continue. 
8) For the sorting order, choose Song Title and the Artist as shown below, then click Next to 

continue. 
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9) For the report layout, choose Align Left 1 as shown below and click Next to continue. 
 

 
 
10) Select Compact as the report style and click Next. 
11) For the report title (and main heading) enter Songs by Genre. Click Finish when done. 
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12) Close the report when finished. It will already have been saved as part of the wizard. 
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Exercise 4. Report Modifications 

 
 
1) Make sure the Songs by Genres report is selected in the Database Window and click the  

button.  
 
In design view, it is useful to position the Toolbox on the side of the screen, so that it is still available 
without getting in the way. 
 
2) Move your mouse to the top part of the toolbox as shown to the right. 
3) Click on this top part of the toolbox and drag so that your mouse turns in to the 

movement cursor.  
4) Drag the toolbox so that it is positioned to the left of the screen as shown. 
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We will put a text box in the Report Footer that will display the total number of songs listed in the 
report. 
5) From the toolbox, click the Text Box icon.  
6) Click in the middle of the Report Footer area to place the textbox. 
 

 
 

 
 
A Text Box will be created in the position you clicked on with a label to the left of it (remember to 
leave room for the label to the left of the textbox when you place it) 
 
7) Click in the Label and change the text from Text23: to Total Songs. 
8) Click in the Text Box (which currently shows Unbound) and enter =count([Song Title]). 
9) Position the label and textbox to the right of the Report Footer area. You can drag them with the 

mouse as shown. 
 

 
 

 
 

Note Dragging on a textbox or label will have a different effect depending on where you are dragging from. 
E.g. 

 Dragging on one of the squares around the border  Re-size the textbox 

 Dragging on a border of the object  Move the object and linked caption/textbox 

 Dragging the top-left corner of the object  Move the object without linked caption/textbox 
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10) Make sure the textbox is selected and click the Align Left  icon so that the resulting total will 
appear in the left of the textbox area. 
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Now we will copy this total so that a total will also appear after each genre group. First we will need 
to make sure there is a space to put a genre total. If you look in your report design you will see that 
there is a Genre Header but no Genre Footer. 
 
11) From the View menu select Sorting and Grouping. 
 

 
 
12) Make sure the Genre field is selected in the top part of the Sorting and Grouping window. In the 

bottom half of the window, change the Group Footer property to Yes. 
13) Close the Sorting and Grouping window when done. 
14) Re-size the new Genres Footer as shown so that it is about ½cm high as shown (each square 

represents 1cm).  
 

 
 
15) Select the textbox if it is not already selected. You will know it is selected when it is surrounded 

by selection boxes.  
16) Select copy by clicking the Copy icon  on the toolbar (or by using another method such as the 

[Ctrl][C] keyboard shortcut). 

17) Click on the Genre Footer to select it.  
18) Paste a copy of the selected textbox by clicking the Paste icon  (or any other method such as 

the [Ctrl][V] shortcut). A copy of the textbox and the linked label will both appear in the Genre 
Footer area. 
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We could drag the new total so that it lines up with the one in the Report Footer but you can easily be 
more precise using some of the built-in tools. 
19) Click on the textbox in the Genre Footer. 
20) Hold down [Shift] and click on the textbox in the Report Footer. Both textboxes will be selected 

as shown. 
 

 
 
21) From the Format menu select Align and then . Both textboxes will now be lined up along 

their right edges. 
22) Follow the same procedure to line up the Total Songs labels as so that the report design appears 

as shown. 
 

 
 
The last thing we will do is to change the properties of the Genre 
Header. Some of the genres will go over more than one page. We will 
change the properties to make sure that the header is repeated at the top 
of each page in these cases. 
23)  Right-click on the Genre Header and select Properties. 
 

 
 
24) Find the Repeat Section property and change it to Yes. Close the properties window. 
25) Save the changes and click the Preview icon  on the toolbar, to view the changes. 
26) Close the report when done. 
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Note Remember that whenever you are modifying properties in Access, you can press the [F1] key for a 
detailed explanation of any property you have selected. It’s a great way to learn about all of the 
different properties, many of which can be extremely useful. 
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Relational Forms 
Creating a form that is based on more than one relational table provides an easy way to add or edit 
data in your database. In the example that we have been working on, when a new CD is entered in to 
the database, the user will most likely want to enter details of songs on that CD straight away. The 
CD details and Song details are in separate tables but we can use a form to bring it all together in the 
same place. 
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Exercise 5. Creating a Relational Form 
1) Make sure you are in the Database Window and go to the Forms section. 
 

 
 
2) Double-click the option that says Create form by using wizard. 
 

 
 
3) From the list of Tables/Queries select Table: CDS. 

 

4) Click the  button to select all of the fields from this table. 
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5) Use the Tables/Queries list again to select Table: SONGS. 
6) Double-click on the following fields from the SONGS table –  

Song Title, Artists, Genre, Duration and Track #. 
7) Click Next to continue. 
 

 
 
The next step asks how you want to view the data in the form. The default option is a form with a 
subform. That means that the wizard will actually be creating two forms. One form will be a small 
form showing song details. This form will be displayed inside a larger form containing the CD 
details. Because of the relationship between the CDS and SONGS table, the songs subform will only 
show the songs for the CD that is being displayed in the main form. 
 
8) Make sure that by CDS is selected and click Next. 
9) The next step asks how you want the subform to appear while it is in the main form. Make sure 

Datasheet is selected so that the subform will appear as a table.  
10) Click Next to continue. 
11) The next step allows you to select a style for your form. Click on each of the different styles and 

then select one that suits you. 
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12) Click Next to continue. 
 

 
 
13) In the last step you can specify names for both the main form and the subform. Call the first form 

CD Entry and the second form CD Entry Subform as shown above. 
14) Click Finish to complete the wizard. The completed forms will be automatically saved and then 

displayed together as a form with a subform inside. 
 

 
 
15) Click the next record button  at the bottom of the form a few times to see how the CDs display 

in the form. Notice the songs on each CD displayed in the subform. 
16) Close the form when complete. 
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Subform 
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Exercise 6. Customising a Form 
Once a form has been created it can be customised to suit your needs and tastes. What follows are a 
few examples of ways a form can be modified. Once you have completed this exercise, you may 
want to experiment with further modifications to your own form. Some of the examples below may 
appear a little different if you chose a different style for your form. While you are working on design 
changes in a form it is a good idea to save the changes periodically. 
 
1) Make sure you are in the Forms section of the Database Window with the CD Entry form selected. 
 

 
 
2) Click the Design button to open the form in design view. Most of our modifications will be 

moving and re-sizing objects to make the form easier to use. 
3) The CD Entry label next to the subform isn’t really needed and it’s 

taking up space that could be used for the subform itself. Click on the 
label so that it is selected as shown to the right and press the [Delete] key 
to remove it. 

4) Move your mouse to the right edge of the form and re-size it to make the form wider.  

5) Click on the subform to select it. 
6) Move your mouse over the resizing handle on the left of the subform and drag 

to the left so that it extends to the left edge of the main form. 
7) Resize the right edge of the subform also to make it as wide as the main form. 
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8) Drag the Description field so that it is under the Purchase and Cost fields. 
Move the Cover field to the right of the form. 

 
 
 
9) Drag your mouse around the Purchase, Cost and Description fields to 

select all of them. When they are all selected, move them in to the centre 
of the form. 

 
 

 
 
At the moment, the Textboxes and the labels for each field are too close together so it is not possible 
to see all of the text in the label. First we’ll widen the boxes a little. 
 
10) Use the method shown above to select the textboxes only (without the labels) for 

the Purchase, Cost and Description fields by dragging a selection box over all 
three textboxes. Note that when you are dragging to select, you don’t need to drag 
the whole way around each object. If your selection area covers at least part of the 
object it will be included in the selection. 

11)  Right-click on one of the selected textboxes and from the menu 
that appears, select Size and then To Widest. This will resize all of 
the selected objects so that they are the same width as whichever 
one is the widest (which in this case would be the description). 
This option is also available from the main Format menu at the 
top of the screen. 
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12) Click on the textbox for the Purchased field so that it is selected as shown.  
13) Move your mouse over the top-left corner of the textbox (the large black square marker) and 

carefully drag to the right to increase the gap between the textbox and label.  
14) With that textbox still selected, hold down the [Shift] key and click the 

text boxes for the Cost field and the Description field. All three textboxes 
should now be selected as shown. 

 
 
15) Right-click on one of the selected textboxes. From the menu which appears, select Align and 

then Right (this option is also available on the Format menu from the top of the screen). The 
textboxes will now line up with whichever one is furthest to the right, which in this 
case would be the one you just moved. 

16) Select the textboxes for the CD #, CD Title, CD Type, Label and Released fields 
using any method shown previously. 

17) While they are all selected, you can re-size them all at the same time. Move your 
mouse over the right selection handle of any one of those textboxes  and drag to 
the right until they are all about the same width as the three textboxes you moved previously (you 
could have also used the Size/To Widest option to get the all the same size). 

18) Use the techniques already shown to increase the gap between the textboxes and labels. 
19) Click on the label for CD #. Hold down the [Shift] key and click on each of the other labels on 

the form so that they are all selected as shown 
 

 
 
20) Resizing labels is a little easier. Because they will always contain the same text when the form is 

being used, you can use an autofit option so they are just big enough to fit their contents. Move 
you mouse over the right resizing handle of any one of the labels  and double-click to 
activate the autofit function. All selected labels will now be resized to fit their contents. 

21) Click the View icon  on the toolbar to view the working form. 
22) The last thing we’ll do is resize the columns in the subform to make them fit better. Move your 

mouse between the column headings and drag left or right to adjust the column width.  
23) Re-size all of the columns until the form appears similar to the example shown. Save and close 

the form when done. 
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